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Training Outline

Purpose of Report

User Roles

System Improvements
Logging On and Registration

Data Entry
— Solid Waste Management
— Printing and Finalizing Data

Welcome to the Sustainable Practices training.

You are welcome to leave the training after your relevant section has been discussed.

However, the Bureau and Office Central Office and HQ users should listen to the entire
presentation

The B/O Central Office user session will follow this one
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The GoToWebinar Attendee View
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Before we get started, | want to review a few housekeeping items and let you know how
you can participate in today’s Web event.

We’'re looking at an example of the GoToWebinar Attendee Interface which is made up of
two parts. The Viewer Window on the left, which allows you to see everything the Presenter
will share on their screen, and the Control Panel at the right. Within that Control Panel is
how you can participate in today’s event, so let’s look at that.

(Transition to Next Slide)



How to Participate Today

Fie View Help
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Hide Control Panel

» Open and close your Panel

)

Default Control Pangl Layout
. e this Startup Lgyout

Arcady on T cal, press #12¢ now » View, Select, and Test your audio

»  We will not be using the “raise your
hand” feature

(=) Questions

X @

'[Enler a question for staff]

Q&A addressed at the end of each
section of the presentation

el

Start Holding your Own Web Events with
GoToWebinar
VWebinar ID: 977-124-241

GoToVWebinar™

Move mouse over the Grab Tab

Clicks 1,2, and 3
By clicking the orange arrow, you can open and close your control Panel

Click 4
From the View Menu you can also set the Control Panel not to auto-hide when inactive if you prefer to keep it always open.

Click 5

The Audio pane provides audio information. (If the organizer has given attendees a choice) By default you have joined the Webinar via
Mic & Speakers.

Click 6
Click Audio Setup to select your computer speaker or headset devices.

Clicks 4,5 and 6

If you prefer, you can join the audio via telephone by selecting Use Telephone, and the dial-in information will be displayed, including an
Audio PIN. If you would like to ask any questions of today’s presenters over the phone, you must enter your Audio PIN in order to have
your line unmuted.

Click 7

During (at the end, etc.) the presentation, you have the ability to send questions to our Webinar staff through the Questions pane. Simply
type in your question and click send. (Optional) At the end of the presentation we will do a Q&A session to answer as many questions as
we have time for.

Click 8

During the presentation we may ask you to answer a question by raising your hand. This option is located on the Grab Tab. (Optional)
You can also indicate that you have a question and would like your line unmuted by raising your hand.

Click 9 and 10

We will address Q&A at the end of today’s session, and as a final reminder, today’s Webinar is being recorded, and everyone will receive
an email within 24 hours with a link to view a recording of today’s event.



Training Norms

* All of the phone lines are muted.

*Please submit questions through the
“Questions” area.

*We will respond to questions at the end of
each training section.

*You may leave the training after the sections
relevant to your work have been discussed.

-However, the Bureau and Office Central and HQ users should listen to the entire
presentation.

-The Bureau and Office Central Office users training session will follow this one.



PURPOSE OF REPORT




Purpose of the Report

» Data are needed for a mandated report to the Office of
Management and Budget and the Council on
Environmental Quality

— Annual update for the DOI Strategic Sustainability Performance
Plan

— Annual DOI Greenhouse Gas Inventory

* Questions address:

— Executive Order 13514 - Federal Leadership in

Environmental, Energy, and Economic Performance
+ Solid Waste and Chemicals Management

— Resource Conservation and Recovery Act
— Pollution Prevention Act of 1990




The Process

How is your data used?

| Analysis\ :
| | by OMB
/ & CEQ

DOI Strategic
Sustainability
' _ Performance
J Plan and
/ g Greenhouse
y Gas Inventory 4

The data input from Field Users are compiled in the Bureau-wide Report. The Bureau and
Office Reports are then used to develop the updated Department’s Strategic Sustainability
Performance Plan (SSPP) and the Greenhouse Gas Inventory. The SSPP is submitted to the
Office of Management and Budget (OMB) and the Council on Environmental Quality (CEQ).
If you are not familiar with them, but OMB and CEQ are part of the Executive Office of the
President.



Sustainable Practices Database
» The Sustainable Practices Database is
located at http://www.nbc.gov/spreport/

» Field User questions are a subset of the
OMB data call

* 18 questions

» Data entry should take 1 hour or less if
data is readily available

» System works best with Internet Explorer
7+

10

System only includes those questions for which data depend on field
responses

10



USER ROLES

1"

11



User Roles

Bureau
5 (@]

Program
Managers

DOI

Program
Managers

12

Here you can see the different layers of users.

12



More on Roles

“Central Office” - second-line program
contacts in your region, area, or state office.

At each level, there is a “solid waste
manager.”

Central and HQ roles perform data quality
review of field data.

Managers track report status for individual
facilities.




Data Quality Assurance

Facility User enters data I

14

14



Home  Facility Data

Status Report for Solid Waste Management

SUSTAINABLE PRACTICES DATABASE

Bureau Report Generator Admin Help Logout

Status Reports

Facility
os

HQ

District Office

OEPC Albuquerque Regional Office

OEPC Anchorage Regional Office

Started

4of12
(33 %)

4012
(33 %)

Email

Email
Email

Email

OEPC Atlanta Regional Office

Email

'OEPC Boston Regional Office
OEPC Denver Regional Office
OEPC Headquarters

OEPC Oakland

Email

Email

Email

Email

OEPC Philadelphia

Email

OEPC Portland
Other

Program Office

Email

Email

Email

*Sample
data only in
this
presentation,
not actual
data

15

inquire as to the progress of the facility’s data entry.

In the “Reports” tab, Central Office users may track the progress of individual facilities.
Select “Status Report for Solid Waste Prevention & Recycling” from the list of options. The
first column shows the name of the facility. The second column shows whether the facility
has started entering data. The third column shows whether a draft of the data is complete.
The fourth column shows whether that draft has been approved by the Central Office. The
fifth column shows whether HQ has approved the data. If a facility has started its data
entry but it is not complete, the Central Office may email the contacts for that facility to

**Please Note that all of the data shown in this training are just for demonstration

purposes and are not actual data reported by facilities **

Questions?

15



SYSTEM IMPROVEMENT

+ Feedback screen for suggestions

16

16



New Screen to Provide Feedback

« After the facility data are successfully forwarded, the user will see a
new screen to provide suggestions to improve the reporting system

+ Please enter comments in the box provided and click “Save”
SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau ReportGenerator Admin Help Logout

Home » Fadility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT Facility: Other

S0k Vst BISV TN Forward Solid Waste Management Data
e |
| Recycling Solid Waste Regional Manager -

« kathleen_chiang@ios.doi.gov

| Waste Disposal The facility Solid Waste data has been routed successfully
T The facility Solid Waste data has been forwarded successtully
Toxics and Hazardous.
L Ciiemcals Monsgement Please provide any sugg orr for improving the report.
| Forward Solid Waste Data

| print Solid waste Data |

USEFUL LINKS
| Facility Notes.

Bureau Contacts

SAVE

17
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LOGGING ON

* Logging Into the System

* Forgot Username or Password
« System Registration

+ Change Password

* Help Resources

18

18



Logging Into the System

Home ContactUs Help Login

LOGIN

Ifyou are first time user, please click here to register

Ifyou forgot your user name and/or password, please click here to have this information mailed o you I

To unlock your account, please click here. Request a new password and itwill unlock your account too.

Please enter your Usemame and Passwaord below and click the ‘Login' bution

Usemame:
Password:

LOGIN
umm TO USERS OF THIS SYSTEM: This is a United States Government computer syster, mamtameu by the Department of the Interior, to provide Official
us. only. Use of this system by any or consentto , refrieval, and
by [ L use may subject violators to criminal, ¢ivil, and for msmplmaw action

19

To Login and register for the site, go to http://www.nbc.gov/spreport/ and then click on the
“Login” tab to see this screen.

Click “register here” if you are a new user.

Click “forgot your username/password” if you've forgotten your password or if you’ve been
locked out of the system.

If you've been locked out of the system due to unsuccessful attempts to login, click on “to
unlock your account”

Only request a password once, it takes up to 5 minutes for you to receive the new
password. Once you receive your new password, copy and paste it directly from the email
into the login page. Be sure to include any punctuation included in the password.

19



Forgot Username or Password

SUSTAINABLE PRACTICES DATABASE

Home ContactUs Help Login

Forgot Username / Password

Please enter your complete email address and indicate the type of assistance you are requesting, then click the "Submif’ button. An email will be sentwith the
requested information.

Email Address:

€ Please confim my Usemame.
€ Please reset my Password
(e Please confirm my Usemame and reset my Password.

SUBMIT

The password will be sent 1o you within 5 minutes. If you request a new password, please be sure that you enter it exactly as it appears in the email that you receive.
Yfou maywant to ry copying and pasting the password from the email into the login page, including any punctuation thatis included in the password. After you
log in, you are 1o change your password to something you will remember by going to the “Admin” tab and selecting “Update Password.”

\'ANI!G ro usmsor THIS SYSTEM: This is a United Stales Gmrnmrntcemnuter svstem mamlamed by the Depariment of the Interior, to provide Official
only. Use of this system by any consentto retrieval, and
bv L use may subject violators lo cnmma\ tml and for dls(mllnarv action.

Notices | Disclaimer | Privacy | FOLA | USA gov | DOl Home | PMB Home

U.S. Dapartmant of the Intetior
Office of Policy Managemant and Budget
Last updated: October 22, 2012
This site has baen optimized for Intemet Explorer7

20

This screen appears if you clicked on “Forgot Username/Password” from the Login screen.
Follow the instructions to request information and log in.



System Registration

SUSTAINABLE PRACTICES

Home ContactUs Help Login

REGISTRATION

Please input your email address to begin registration,

Email Address: |

SUBMIT
WARNING TO USERS OF THIS SYSTEM: This is a United States system, 1 d by the D of the Interior, to provide Official
L us. G only. Use of this system by any jor userc consentto retrieval, and
e by personnel. | use may subject violators 1o criminal, civil, and for disciplinary action.

Notices | Disclaimer | Privacy | FOIA | USAgov | DOI Home | PMB Home

U.S. Department of the Interior
Office of Policy Management and Budget
Last updated: Oclober 22, 2012
This site has bean optimized for Intamet Exploter?

21

If you clicked on “click here to register” on Login screen, this page will come up. We have
added this step to prevent multiple registrations for the same person. When you enter
your email here the system will check whether you already have an account. If you already
have an account, you will be routed to a page where you can request that your username
or a password be sent to you. If you do not have an account, you will be routed to the
registration page, which is on the following slide.



SUSTAINABLE PRACTICES DATABASE

Home ContactUs Help Login

Registration

It's important to
pick a password

Pilease complete the form below and click the Submit button. If you need help with this registration process, click on B
meetthe following criteria

= Alleast 12 characters and no more than 15 characters
* Contain one upper-case alpha, one lower-case alpha and one numeric character th at fOI |0WS these
= Contain one special character such as @, 5, or & 3 ru leS'

USER INFORMATION

Bureau: [SelectaBureau =]
s st was g p Once you pick
hold Cir Key to select additianal region names. : your bureau and
T o region, you will be
hold b Key to select additiona! facility names. =l g|ven a IiSt Of
FirstName: =

facility names to
LastName: .
Emalk [brian_milchak@ios.doi gov pICk fFOm here
Phone Number: 1
Desired Usemame: [brien_milchek@iosdoigov
Password: ]
erify Password: ]

Submit

22

This is the screen that appears when you submit an email address that does not already
have an account. Enter your information into the form to register for the website. Then
click “Submit”



More on Registration

« User name = your email address

» Central office program manager will be
notified of new facility user registrations.

* You can register to enter data for more
than one facility.

* If you move to a new facility, your central
office program manager can update your
user profile with your new contact and
facility info.

23

Generally, your user name is the same as your email address. You may specify a different
user name during the registration process if you like. Please keep a record of that user
name for future reference.



Site Administration

Change Password

SUSTAINABLE PRACTICES DATABAS

Heme Facility Data Reports Bureau ReportGenerator Admin Help Logout

Action ltem
pdate Password

Approve Solid Waste
Management Data

Manage User Accounts

Change User Password
Manage Facilities List
Create Email Listing

Listing - Facilities and
Contacts

Manage Regions List

Add Notes

Description
This tool allows user to change their password fo access the system
This tool allow admin user to approve Solid Waste data of a facility

This tool allows user to edit or add users to the system. Regional / State program leads should review users
gl in their to ensure are the system

This tool allow user to change password for existing users.
This tool allows userto edit or add facilities to the system.
This tool allows user to create an email listing of all the users in region or bureau

List of contacls associated with facilities

This tool allows user to edit or add regions to the system

Add notes to assist with preparing this report in the future. Future users from your region/bureau will have access
to these notes.

Notices | Disclaimer | Privacy | FOIA | USA gov | DOI Home | PMB Home

U5, Department of the Interior
Office of Policy Management and Budget
Last updated: October 23, 2012
Thissite has been oplimized for Internet Explorer 7

24

If you are able to log into the system, you may change your own password by selecting the

“Admin” tab and then clicking on “Update Password”

24



Change Password

RENT OF
-‘,e-‘ RS

- &

SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau ReportGenerator Admin Help Logout

Change Password

To update your password, please enter your new password and then confirm it. Avalid password must meet the following security standards:

« Be atleast12 characters and no more than 15 characters

« Contain one upper-case alpha, one lower-case alpha, and one numeric character.
# Contain one special character such as @, §, or &

.

The new password canlcontain the old p (e.g.theoldp cantbe'p ' and the new password ‘password1).

Password: esssscssssssee

Confirm Password: I

25

If you click on “Update Password” this screen will appear. Simply type your new password
into the fields provided. Then click on “Save” and your password will be changed.



Help Resources

Send us an
email

ContactUs Help

Login

Department of the Interior FY13 Sustainable Practices Database User Aids

« Signed DOI Data Call memo for FY 2013 Reporting on Solid Waste and Chemicals Management

o FY 2012 Training Presentations - Updated FY 2013 Information Coming Soon

« Sustainable Practices Database Field User Training (3.5MB)
e Sustainable Practices Database Central Office User Training (EEER (3.8 MB)
» Sustainable Practices Database Bureau Headquarters User Training (EEE3 (1.1 MB)

Check out

o Frequently Asked Questions

the FAQs

e Feedback Form

« Other useful links:

& Guidance on waste-to-energy and waste diversion
« EPA published standard volume to weight conversion factors
« Conversion Factors used in this data call

26

If you need help, there are many resources available under the “Help” tab. Some of the
resources are highlighted here.

Training presentations will be added to this page as well.



Feedback Form

» Use for all your questions and or
comments.

* Your feedback will automatically be sent to
the DOI contacts (OCIO and OEPC) as
well as designated bureau HQ contacts.

Feedback

Please Use This Form To Send Your Questions or Comments.

Name:
Email Address li
7

Questions?

27



DATA ENTRY

» Solid Waste Questions

* Print Report

* Finalize Data

* Central Office Data Review

28

28



PREVIEW OF
SOLID WASTE QUESTIONS

29

29



Navig

ation
Your current ;

location within the e T
system is shown s - =
here s

o

SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau Report Generator Admin Help Logout

Home » Facility Data »

Your facility
SOLID WASTE MANAGEMENT Facility: OEPC Albuquerque Regional Office name |S

Selid Woste Frevention Instructions to enter data shown here

navigation Recyang

» Althis time we are only collecting information for Solid Waste Management. If you have questions, please contact your Bureau
Contacts.

» Users can save partially- complete or complete Survey data by clicking on the SAVE button at the battom of the page before

|
|
Waste Disposal '

« Your data will be lostif you do not click SAVE atthe bottom of @ach page.

Toxics and Hazardous
Chemicals Management
# Click onthe 2012 data under "Useful links" for the reports for FY 2012,
| Forward Solid Waste Data | + Click onthe Bureau Contacts under “Useful inks" to see your reviewers.
= When ready, Ciick on any section to énter data
| Print Solid Waste Data I « ‘Youmust Forward Data before your report is complete
USEFUL LINKS
[ Facility Notes |

| Bureau Contacts |

| 2012 S0lid Waste Data |

30

Here, the “Facility Data” tab has been selected.

They system has a left-hand side navigation bar, which lists solid waste management
sections of the report.

The user would complete each item under Solid Waste Management to complete the
report.

30



Navigation (cont'd)

Find the name SUSTAINABLE PRACTICES DATABASE

Home FacilityData Reports Bureau Report Generator Admin Help Logout

and contact
information for
your designated
Central Office and
bureau/office HQ
contacts.

Home » Faciity Data »

SOLID WASTE MANAGEMENT ~ Facility: Other

L Instructions to enter data

Recycling

= Althis time we are only i Solid Waste If you have questions, please contact your Bureau
Contacts.

Wasle D

= Users can save partially-complete or complete sunvey data by clicking on the SAVE button atthe boltom ofthe page before

Toxics and Haza
Chemicals Management

* Your data will be lost if you do not click SAVE atthe boftom of each page.
2013 data undet "Useful links™ for the reports for FY 2013.
+ Clickon the Bureau Contacts under "Useful links™ o see your reviewers
« \When ready. Click on any section 10 enter data.

+ You must Forward Data before your reportis complete.

Review the Data
you submitted
for FY13. You

may print the
FY13 report and
refer to it when
compiling your
FY14 responses.

31

There is a link to bureau contacts for more information on how to complete this report.

You can click on the link on the lower left to see your facility’s 2013 data. The data have
been locked and cannot be changed.



Facility Notes

SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau Report Generator Admin Help Logout
Home » Fadility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT ~ Facility: Other

Solid Waste Prevention o
Facility Notes
REsycng Add Notes:
‘Wasle Bma' Add notes o assist with preparing this report in the future. Future users from your facility will have access 10 these notes.

Enter notes
here for next

year’s report | \CEaD
and view
notes added B « Talkto Sam for recycling data. (10730/14)

in previous

years

SAVE

Existing Notes for this Facility:

32
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SUSTAINABLE PRACTICES DATABASE

ports  Bureau Report Generator ~Admin

Home > Farility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT Facility: OEPC Albuquerque Regional Office
Solid Waste Preventi s .

l = otp FYevEicr) A. Solid Waste Prevention

REWLW Nate: You must click on “SAVE” below of your data will be lost.

‘Waste Disposal 1) Isyour facility in leased space?

C}"u&dcls zlEnuMHadeuus Cves O N
t
il healen bl 1a) Isyour facility in leased space within 3 multi-tenant building?
Forward Solid Waste Data C ves C No
Print Solid Waste Data 2) Does your facility have an active office products recycling program?

USEFUL LINKS Cves C Ne

Faciity Notes 3)  Does your faciity have housing units?
C c
Bureau Contacts Yot No

3a) I . how marty housing units operated by your facility have access to an active
l 2011 Solid Waste Data household products recycling program?

units of [ total units
The database wil caleulate the percanta e based on the numb er of units you provide hare.

4)  Did your facility institute new, substantially improved, or updated non-hazardous solid waste
in FY 20127 For additional information on solid waste prevention please go to:
hitp://www epa.gov/R egion7Awaste/solidwaste/reduce _waste.htm
 Yes © No

It yes, explain (255 characters max):

| 33

Click on Solid Waste Prevention to begin data entry.

This screen will appear

The questions shown here are pretty straight-forward, just indicated whether your facility
(1) is in leased space, (2) has a recycling program, (3) has housing units.

33



Solid Waste Prevention (cont'd)

Did your facilty institute new. substantially impraved, or updated nan-hazardous soiid wasts 7)  Witnin FY 2012 contracts for your facility, eid any specificalions inciude a requirement for Waste:
In F 20127 For additional information on solid waste prevertion please go to Reduction Plans (FAR Clause 52.223-10) In demolition, construction, and service contracts to achieve
LD fiwaw €03, QOVIR EgIONT waste/solidwastefreduce_waste hm waste tiversion goals? Provide specific exampies

&

c c
Yes Ne © ves T No T NotApplicable

I yes, explain (255 characters max): ‘

5)  Does your facility cOmpost any of its waste (ether onsite or offsite)? 8) Wnatis your facility’s goal for solid waste diversion by 20157
DOfs Wasts Dirrion goul s 50% by 2015,
Cves Mo
Please input enly numbers.
It yes, select the type of composting, | Select s
e e sbie MAMPY 154 EHREAPY I SRS A SN ARG o o 9) Do you have onsite waste OIspasal, such 35 a Ianatil, 3t your facilty? Please answer yes* If your

faciity has a permitted landfil that was in operation anytime between 1980 and today.

e

Dig your facilty have any cemoltion projects during FY 20127
C Yes Mo

Cves T Ne
623) I yes, how many demolition projects managed by and/or conducted at your facilty include the recovery
of construction materials?

demolition projects of total demoltion projects in FY 2012
e

Within F'Y 2012 contracts for your facilty, did any specfications include a requirement for Waste
Reduction Pians (FAR Clause 52 223-10) in demoifion, consiruction, and service contracts o achieve
waste aversion goals? Provide specific examples.

C yes © Noe © Notapplicable

Save partially-complete or complete
survey data by clicking on the “SAVE”

button at the bottom of each page
before navigating elsewhere.

If you do not click on “SAVE” your
data will be lost!

34

Note that there are links to hints and helpful information for answering the questions, such
as links to “non-hazardous solid waste prevention practices” and “recovery of construction
materials”

Note that for question #5, the question on composting, re-use of materials onsite such as
mulch or grasscycling in landscaping is not composting. To count as composting, material
must be decomposed in some manner before it is re-applied to landscaping.

For question #9, we are asking whether you have an onsite landfill.

When you are done entering data on this page, click “SAVE” — THIS IS CRITICAL, YOUR DATA
WILL NOT BE SAVED UNTIL YOU CLICK THE “SAVE” BUTTON

34



Recycling

SUSTAINABLE PRACTICES DATABASE

Reports Bureau Report Generator Admin Help Logout
Home » Facllty Data > Solid Waste Management »

SOLID WASTE MANAGEMENT  Facility: OEPC Albuquerque Regional Office

Solid Waste Prevention 3
B. Recycling

) Recycling

1) Indicate which of these commodities your faciity recycled during FY 2012 (10/1/12 - 9/30/12). Waste
for energy may not be counted as recycled.
Guidance on waste-to-energy and waste diversion

MNote: You must click on “SAVE” below of your data will be lost.

Toxics and Hazardous
Chemicals Management

I

™ Aluminum ™ Keyboard

Forward Solid Waste Data  Antitreeze I~ Lignt Ballasts
Print Solid Waste Data I Asphait ¥ Manure

USEFUL LINKS ™ Batteries (Leadvacid - car) ™ Mixed Paper
Facility Notes I~ Batteries (Lead/acid - truck) I~ Monitor
I Batteries (NCd rechargeabie) I Newspaper
I~ Batteries - Mixed I Notebook PC
2011 Solid Waste Data
I~ Brick " Paliets
I Car Tires ™ Plastic (#1PETH#2HDPE) S |
I Cardboard ™ Printer Stll’lg e
ream
I Carpet I Scrap Metals Category
Co-mingled I~ Ceiling tiles I Single-Stream Mixed Recyclables (steel and includ
o aluminum cans, glass and plastic bottes, mixed Includes
categow includes ™ Co-mingled (glass Al cans, plastic) paper, cardboard) .
: containers
most containers I Concrete I steel Cans and paper

35

Under “Recycling” click on the commodities that your facility recycled during FY 2014.
Then click “SAVE”.



Recycling (cont'd)

B. Recycling

Mote: You must click on € SAVE® below or your data will be lost.

Please input the actual or estimated weight or volume of the total amount of each commodity recycled during FY 2013 from your|
facility. There are volume to weight conversions programmed into the system for most commodities,

+ EPA published standard volume to weight conversion factors.

+ Conversion Factors used in this data call.

Select Recycled C&D Waste only for items recycled as the result of construction and demolition projects.

* C&D waste = construction and demolition waste.
« Ton= 2,000 pounds
+ Metric Ton = 1,000 kilograms = approximately 2,205 pounds

You must enter amount and select Type of Recycling for each commodity.

factors used are

through these

Commodity | Amount Recycled Unit Compactediot Type of Recycling
Other Ibs ~ [compacted ]
Aluminum Io Jlbs j | ! A:I

ycled C&D Waste
Cardboard IO ‘Ibs _'J |uncompacled_'_| Other Recycling
Mixed Paper |0 Jlbs :! |unoompacled j lother Recycling j

SAVE

Conversion

available

links.

Select the Type
of Recycling
here to avoid
receiving an
error later on

For each commodity that you selected on the previous page, you will be asked to enter the
amount recycled. You may enter the amounts in a variety of units, as shown here, but they

will be automatically converted to tons for the final report.

You must enter the amount recycled, there are some options for units you can use such as

tons, pounds, cubic yards, etc.

Under “type of recycling” you must enter whether the recycled waste is recycled

construction and demolition waste (C&D waste), composted, or other recycling. Other

recycling is generally recycled municipal solid waste.

Click “SAVE” when you’ve entered all of your data for the commodities recycled.

36



Recycling Data Tips

* Check your units — 100 tons of paper = 200,000
pounds of paper, which is a lot of paper.

» Check estimates of amounts recycled — If a
facility reports 200,000 cys paper recycled, this is
equivalent to 75,000,000 pounds. Please do not
over estimate.

+ Be careful with decimals and zeros - extra zeros

can greatly increase your recycling amounts.

37
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ENT OF

\ i : SUSTAINABLE PRACTICES DATABASE

2 S
N3AcH 3. 1%

Home Facility Data Reports Bureau Report Generator Admin Help Logout
Home s Facility Data » Solid Waste Management s

SOLID WASTE MANAGEMENT Facility: OEPC Albuquerque Regional Office

OISRV NN B. Commodities Recycling

Recyeling For FY 2012, your faciliy recycled
100 Ibs of Uncompacted Antifreeze - Other Recycling = 100.000 Ibs

Totak 150 Ibs = 0.075 tons

Total Composted Recycling: 50 1bs = 0.025 tons
Total C 01bs=0000tons

Total Other ing: 100 Ibs = 0.050 tons.

f:l'O)d!:S and Hazardous

Mar

Forward Solid Waste Data

l ‘Waste Disposal I 50 Ibs of Uncompacted Manure - Composted = 50.000 Ibs

The Recycling data has been saved for this facility
Please proceed 1o Solid Waste Management Waste Disposal (

Print Solid Waste Data

USEFUL LINKS
| Facility Notes ]

| Bureau Contacts I

| e0isolawestepata |

38

After you’'ve entered information for your commodities recycled, you will see a summary of
the data you entered for those commodities.

After reviewing the data, click on the link to proceed to the “Waste Disposal” section of the
report.



Waste Disposal

s Bureau Report Generator Admin Help Logout

All Other Trash (Municipal [Tooooe  |[ibs =
Solid Waste) sent to Waste.

to-Energy
of Total amount of waste sentto
‘Waste-to-Energy facility, or
‘waste combustor, to be buned
for energy. Include tra sh that
‘Wwas notrecycled and was sent
Note: You must click on “SAVE" below or your data will be lost. foaveasie in-sriesgy AU

«| Do natinciude C &0 waste
| reported above.
«f Do notinclude any materials
Type of Waste Amaunt | Unit ! focycod.
o Do notinclude trash sent o a

Construction and Demolition [Toooos | [1bs = ( waste incinerator that is nota

nagement >

Facility: OEPC Albuquerque Regional Office

C. Waste Disposal

Please input only numbers. Yfou can input 0 if you do not have any of these types of waste.

‘Waste Sent to Landfill or ‘wasle-to energy facility
‘Waste-to-Ener gy (C&D Waste)
« Total amount of construction &
demolition waste sent for
disposalin FY 12,

o Do not include any materials

Need help estimating waste amount?

Guidance on waste-10-energy data

Include amounts of waste
resulting from natural resource
management at tties such as
illegal dumping clean-ups,
storm debris clean-ups, river
debris clean-ups for
hydroelectric dams, and habitat

restoration projects

Al Other Trash (Municipal 100.0000 Ibs E (

Solid Waste) sent to Landfill
| Total amount of waste sent to
landfill during FY 12,
+ Do notinclude C & Dwaste
reported above. Y d h
+ Do notinclude any materials

OAT ou must enter data on this screen or
o Do notinclude trash sentlo a 3 H

Vaslnto snscgy iy you will receive an error message.
+ Inciude trash sentto a waste
incinerator thatis not a
waste-10 energy facility.
o Include trash amount here if
You are nol s ure what type of
facility it goes to.

Provide comments here about your waste reported, if any

ANl Other Trash (Municipal 10,0000 Ibs X 39

Solid Waste) sent to Waste.

In the Waste Disposal section you will be asked about the total amount of waste disposed
and not recycled.

Do not include any amounts recycled on this page.

Report amounts for:

- Construction and demolition waste not recycled

- Municipal solid waste sent to the landfill and not recycled
- Waste sent to waste-to-energy facilities

Click on “Need help estimating waste amount?” if you need assistance.

Also please note that any waste burned for energy is not considered to be diverted waste.
You may still report the amount burned for energy here. Please see the linked Guidance on
Waste-to-Energy Data.
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Waste Disposal (cont'd)

Home FacilityData Reports Bureau Report Generator Admin Help Logout

Home » Facility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT Facility: OEPC Albuquerque Regional Office

C. Waste Disposal
Recycling The Waste Disposal data has been added for this facility
Waste Disposal Category | Undiverted waste ons) Recycled (ons) Diversion rate
m Construction & Demolition 0.005 VDUUD 0.00%
Chemicals Management Municipal 0055 0075 5769%
[@] Total 006 0075 55.56%
Wl ;?&Ezr:nﬂ\: 1?:: ;z\cu:annvwasle diversion is

USEFUL LINKS Recycled materils + Trash
Facilty Notes
Gas
Bureau Contacts

Your undiverted municipal solid waste has resulted in 3pproximately0.040161 MT COZe (metric tonne carbon dioxide

2011 Solid Waste l;atz equivalent) in greenhouse gas emissions.

*Greenhouse Gas Emissions amount = short fons of aste x 0.7302 MTCOZefshort ton

Department Waste Diversion Goak: 50% or more by FY 2015
Your facility has met or exceeded the Department’s goal.
Guldance on how fa enhance your Waste Diversion and Recycling Program,

k: 50.00 %."

State Waste Diversion Goat:
You have met or exceeded your State's waste diversion goal.
* Mote: Racant changes to State warte divatsion goals may net ba ccurate ly taflacted hare

Please proceed to Solid Waste Management Toxics and Hazardous Chemicals Management 40

Once you have entered and saved all of your data for Recycling, you will see this screen.
Note that there are additional links providing information on how to enhance your waste
diversion and recycling program and about recycling goals. Click on the link at the bottom
to “Proceed to Solid Waste Management: Toxics and Hazardous Chemicals Management.”



Data Entry Guidelines

Facilities must provide data for undiverted waste in addition to what was
recycled for both municipal solid waste and construction and demolition
(C&D waste).

Undiverted waste is the amount that went to the landfill and/or waste-to-
energy (WTE) facilities.

Facilities reporting only amounts recycled and a 100% recycling rate
will be asked to explain why they have such a high recycling rate.

Report amounts of biomass/wood chips burned onsite for heat or
electricity as WTE if wood would have otherwise gone to a landfill

Even if waste disposal is free, the amount disposed of should be
reported.

Please do not double count. If a quantity of a commodity is reported as
recycled, that quantity should not be included in the landfill or waste-to-
energy amounts.

41
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Toxics And Hazardous

Chemicals Management

Home » Facility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT  Facility: OEPC Albuguerque Regional Office

Solld Waste Prevention . .
;} Toxics And Hazardous Chemicals Management
Recycling Mote: You must click on “SAVE” below or your data will be lost.
Waste Disposal 1) Briefly describe what your facility has done to reduce the purchase of toxic and hazardous chemicals

Do not report quantitative information (volume or doliars) on chemicals or chemical-containing products
’W purchased or reduced
Chemicals Management
je have aplan o replace mercury with non-mercury
| Forward soid waste pata
Print Solid Waste Data

USEFUL LINKS

Facility Notes
Bureau Contacts
2011 Solid Was]e Data

42

This is the page to enter information on your facility’s efforts to reduce the purchase, use
and disposal of toxic and hazardous chemicals. Enter your narrative information and click
“SAVE.”



PRINT REPORT
FORWARD DATA

43
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Printing your reports

* Print a copy of each report before you
finalize!

— Hard copy can be circulated for review and
approval within your facility prior to finalizing
— Click on “Print Solid Waste Data”

— Navigate to web browser and select print
function there

44

44



When you are
done entering
data, you may
print your
report here.

Printing your reports

SUSTAINABLE PRACTICES DATABASE

Reports Bureau Report Generator Admin Help Logout

Home » Facilty Data » Solid Waste Management »

Facility: OEPC Albuquerque Regional Office
SOLID WASTE MANAGEMENT

Solid Waste Prevention Summary: Solid Waste Management -
Click on the PRINT bulton to print the report
‘Waste Disposal

R 1) Is your facilty in leased space?
Chemicals Management

Forward Solid Waste Data

A. Selid Waste Prevention

12

Is your facility In leased space within a multi-tenant building?

2)  Does your facility have an active office products recycling program?

USEFUL LINKS

Facility Notes
" how many housing units operated by your facility have access to an active
Eiriean o household products recycling program?

units of total units

2011 Solld Waste Data The database will ealculate the percentage based on the number of units you provide here

4)  Did your facility Institute new, improved, or updated solid waste
practices in FY 20127

3)  Does your facility have housing units?

If Yes, please explain (255 characters max):
5)  Does your facility compost any of its waste (either onsite or offsite)?

45

If yes, select the type of composting.
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Forward Data

SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau Repert Generator Admin Help Logout

Home » Facility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT Facility: OEPC Albuquerque Regional Office

i P . "
| Solildiyeslo RIEvention } Toxics And Hazardous Chemicals Management

| F!ecycrlng J The Toxics And Hazardous Chemicals Management data has been saved for this facility.

} Please proceed to Solid Waste Management Forward Solid Waste Data

Click here for Waste Disposal

your report to Toxics and Hazardous
be fonvarded Chemicals Management

to the

regional, Print Solid Waste Data
state or area USEFUL LINKS

office | Faclity Notes J

[ suresu contacts |

[ 2011 S0l weste pata |

46

When you have completed entering the data for Solid Waste Management or Green
Purchasing, you must “Forward Solid Waste Data” before it is sent to the Central Office for
approval.



System Checks

Facility: District Office

Forward Solid Waste Management Data

Your data is complete but

The total recycled amount for your facility is at least 10 imes greater than the FY 2011 recycled amount
The total trash amount for your facility is atleast 10 times greater than the FY 2011 trash amount

The total recycled amount for your facility is at least 1000 tons more than FY 2011 recycled amount

Flease verify the data you've entered and/or provide an explanation here

Please select reason’s:

I Facility Expanded Recycling/Composting

™ Facility Started New Recycling/Composting

I Facility had a singular event that increased/decreased quantities
I Disposal increaseidecrease was due to changes in Visitation
I™ Usage or Temporary Facility Closure

 Improved Tracking

I™ weighing Trash instead of Volume Estimates

I~ Added New Materials to Recycling Program

Please explain:

More accurate tracking

+ The system checks for data completeness and
consistency when you click on “Forward Solid
Waste Data”

- Errors like the one shown here appear when:

* Recycling is 10 times or greater than last
year’'s amount

*Recycling is less than 10% of last year’'s
amount

*Greater than 50 ton variation in trash or
recycled amount if total waste is 100 tons or
less.

* Non-diverted waste is 10 times or greater
than last year’s amount

« Non-diverted waste is 10% or less of last
year’s amount

*Greater than 1,000 ton variation in trash or
recycled amount

* Recycling rate is 100%
* You must either correct your data or provide an
explanation when you receive this error.
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System Checks

« These errors show

ragement »
that we have not
Facility: OEPC Albuquerque Regional Office entered a" Of the
Forward Solid Waste Management Data required data_
Your data on Solid Waste Management Data is not complete yet. Please enter all the data and then finalize
it. Please complete the following data L] We must

The data on the Recycling Program / Solid Waste Prevention is not complete.

« Explanation on new, substantially improved, or updated solid waste prevention practices (Solid Com plete these
Waste Prevention #4).
« Explanation on Requirement for Waste Reduction Plans.(Solid Waste Prevention #7) entries pr|0r to
forwarding our

data.
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If your data are not complete when they are finalized, a screen will appear to tell you what
information is missing and must be completed before it can be finalized. You must enter
this data before it can be submitted to your Central Office.
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Forward Data

s Bureau Report Generator Admin Help Logout

ragement »

Facility: OEPC Albuquerque Regional Office

Forward Solid Waste Management Data

« Afteryou click on "Conltinue® your regional or central office will be notified that your facility data are available for review.
* Afteryour data have been reviewed at the regional or central office level, your data will be forwarded to your bureau
headquarters for review and inclusion in your bureau's Sustainable Practices Report
If all the data for Solid Waste has been added / edited completely, check the box to forward the facility data
for regional approval

) ™ Forward the Solid Waste facility data for approval.

CONTINUE

49

If you have completed all of the information required by the Sustainable Practices
Database, you will see this screen when you click on “Finalize Data”. Click on the box to
forward your data, and then click on “Continue” for your data to be forwarded to the
Central Office for approval. Your Central Office manager will receive an email notifying
them that your report has been finalized.

Once you have finalized your data, the facility user will not be able to edit it. If you discover
an error, contact your Central Office to return the data to you so that you can make the
change. If data is returned and sent back to you, you must finalize the report after you
make your changes so that the Central Office will be notified you have made your changes.

You will receive an email if your Central Office returns your report to you for changes.
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New Screen to Provide Feedback

+ After the facility data are successfully forwarded, the user will see a
new screen to provide suggestions to improve the reporting system

+ Please enter comments in the box provided and click “Save”

SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau ReportGenerator Admin Help Logout

Home » Fadility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT Facility: Other

[ = .
IS0k Vst Brev erton Forward Solid Waste Management Data
I —— |

| Recycling Solid Waste Regional Manager -

« kathleen_chiang@ios.doi.gov

| Waste Disposal The facility Solid Waste data has been routed successfully
T The facility Solid Waste data has been forwarded successtully,
Toxics and Hazardous
Chemicals Management Please provide any orr for improving the report.

sugg
7
Forward Solid Waste Data

| print Solid waste Data |

USEFUL LINKS
Facility Notes
| Bureau Contacts I
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This screen will appear after you have successfully forwarded your facility’s data.
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Central Office Data Review

At this stage:

- If edits or clarification are [ ™ Facility User enters data

necessary the Central _\l‘/lﬁ

Office program reviewer - l—————l "
sends report back to r Facility User finalizes data and forwards it for review

k.28

Facility User.

- Then the Facility User
makes changes and re-
finalizes the data, sending
the report back to the
Central Office.

-If no changes are needed,
the Central Office User can
forward data to the Bureau
HQ User

51

Once the Central office receives the data, the Central Office may decide that there is a
problem with the facility data that must be corrected before it can be forwarded on to the
bureau or office HQ level for approval. If there is a problem with facility data, the Central
Office User may send the data back to the facility user for correction by “Unapproving” or
“Returning” it.

If the Central Office sees that the data for its facilities are ready to be forwarded on to the
Bureau HQ level, the Central User may then forward the data on. For more information on
this process, please see the Powerpoint presentation for Central Office Users.

51



Historical Reports

Home Facility Data Reports Bureau Report Generator Admin Help Logout

Solid Waste Reports - Historical Bureau Data
Report only includes data for active facilities. Previous years' data for facilities that are currently deactivated are notincluded
All amounts are in tons.
Click on the bureau name to see the data for the regions.
2012 2011 2010
Recycled (tons) Waste tons) Waste Diversion  Recycled (lons) Waste (tons) Waste Diversion  Recycled (fons) Waste (tons) Waste Diversion
Total 226,069.07 94,172.02 70.59% 4161 115.19 26.54% 4,875.27 8,380.88 36.78%
08 157 0.00 100.00% 0.49 90.18 0.54% 1,521.42 48.38 96.92%
NPS 102,261.63 59,364.81 63.27T% 4112 25.01 6218% 332541 1,630.00 67.11%
FWS 22,088.18 24,517.48 47.39% 0.00 0.00 0.00% 022 0.00 100.00%
UsGs 1,79310 937.54 65.67% 0.00 0.00 0.00% 0.00 0.00 0.00%
BOEM/BSEE 4387 6741 38.42% 0.00 0.00 0.00% 0.00 0.00 0.00%
OSMRE 40.06 38.76 50.82% 0.00 0.00 0.00% 0.00 0.00 0.00%
BlA 0.14 0.00 100.00% 0.00 0.00 0.00% 0.00 0.00 0.00%
BLM 25,999.04 4,261.36 85.92% 0.00 0.00 0.00% 0.00 0.00 0.00%
BOR 7353113 4,713.88 93.98% 0.00 0.00 0.00% 28.22 6,702.50 0.42%
NBC 310.37 270.79 5341% 0.00 0.00 0.00% 0.00 0.00 0.00%
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Within the “Reports” tab, there are reports with historical data available. This report
compares solid waste data for the last three years.

To drill down within the bureau, just click on the Bureau name, and on the following screen
click on the Region name. You will then be able to see the facility historical data.

IH

If you “Download historical data in Exce
available.

you will see data for all years that data are



Historical Reports

SUSTAINABLE PRACTICES DATABASE

Facility Data Reports Bureau Report Generator Admin Help Logout

2010 Reports

Click on the Solid Waste report1o print a copy of solid waste repon for that facility.
Facility (Region) Solid Waste
Office of the Secretary
HQ
District Office Solid Waste Report
OEPC Albuguerque Regional Office Solid Waste Report
OEPC Anchorage Regional Office Solid Waste Report
OEPC Atlanta Regional Office Solid Waste Report
OEPC Boston Regional Office Solid Waste Report
QEPC Denver Regional Office Solid Waste Report
OEPC Headquarters Solid Waste Report
OEPC Oakland Salid Waste Report
QEPC Philadelphia Solid Waste Report
OEPC Portiand Solid Waste Report
Other Salid Waste Report
Program Office Solid Waste Report
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You can also download complete reports for each facility for FYs 2006 - 2013.
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Questions can be emailed to SPReport@ios.doi.gov

Thank you for your time and attention!

QUESTIONS? WRAP-UP
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